Your business faces a difficult decision with an aging desktop fleet. You ultimately have two choices: You can replace the systems now, or you can push the capital expense to the next fiscal year. How do you know when it’s the right time to invest in a boost for your business?

To help you make the best decision, we compared two new desktops powered by Intel processors—an All-in-One PC and a Mini Desktop—to a five-year-old legacy desktop tower much like the ones your business might have in place. With thorough hands-on testing and research, we looked at the benefits that replacing the systems could provide for your business when it replaces a fleet of legacy desktop towers with new All-in-One PCs or Mini Desktops.

Your employees have the opportunity to be more productive with faster and more reliable new desktops. New desktops are also more efficient, and your business can realize significantly lower power costs. By leveraging both improved and new technology, IT staff and users benefit from simplified, out-of-band management while gaining advantages in connectivity and workspace savings.
ENABLE EMPLOYEES TO DO MORE WITH FASTER SYSTEMS

Promote productivity with up to 145% better system performance

Waiting on a slow PC can be painful. A faster, more responsive desktop means your employees can finish the same tasks in less time, ultimately providing your employees an opportunity to be more productive. We used five industry-standard benchmarks to show the performance boost your employees can get with a new Intel processor-based All-in-One PC or Mini Desktop. The new Intel processor-powered desktops outperformed the legacy desktop tower on all of the performance benchmarks.

For detailed specifications of the test systems, see Appendix A. For step-by-step details on how we performed our benchmark testing, see Appendix D. For more on the benchmarks, see Appendix E.

As Figure 1 shows, we found the All-in-One PC and Mini Desktop provided significantly better system performance than the legacy desktop tower—145 percent and 114 percent, respectively. Note: We calculated the percentage wins for the All-in-One PC and Mini Desktop on each benchmark, and then calculated system performance by taking the geometric mean of those percentage wins versus the legacy desktop tower. For more details on how we calculated the system performance, see Appendix B.

Figure 1: System performance improvement for the All-in-One PC and Mini Desktop vs. the legacy desktop tower. Higher numbers are better.
Faster desktops for your employees mean less waiting while working and an opportunity for increased productivity.

So what does better system performance mean for your business? If your average employee spends 10 minutes a day waiting to do the types of tasks included in our benchmarks, 145 percent better system performance means your average employee could save almost 6 minutes per day or 23 hours per year when moving from the legacy desktop tower to the All-in-One PC. As Figure 2 shows, replacing desktops represents a significant opportunity for increased productivity as the size of the desktop fleet increases. For example, a business replacing 10,000 legacy desktop towers with 10,000 new All-in-One PCs could see significant savings over four years—5.923 minutes saved daily per employee would add up to over 900,000 total hours saved that employees could use for other tasks.¹ ²

**Figure 2: Time saved in hours over four years when replacing a fleet of legacy desktop towers with All-in-One PCs.**

PAY LESS FOR POWER WITH MORE EFFICIENT SYSTEMS

Save at the outlet with up to 60% fewer watts at idle and up to 42% fewer watts under load

Why waste energy and dollars with inefficient older desktops? We found that both the All-in-One PC and Mini Desktop consumed significantly less power than the legacy desktop tower—and notably, consumed less power under load than the legacy desktop tower consumed at idle. The All-in-One PC consumed 55 percent fewer average watts while idle and 35 percent fewer average watts under load than did the legacy desktop tower. The Mini Desktop consumed 60 percent fewer average watts while idle

¹ Based on a conservative estimate that a hypothetical mix of productivity tasks would take an average of 10 minutes per employee per day with the legacy desktop tower. With 145.3 percent better system performance, the same mix of tasks would take an average of 4.077 minutes per employee per day with the All-in-One PC, saving 5.923 minutes per employee per day.

² Based on a 46-week work year per employee, which includes holidays, vacation, and sick leave (www.bls.gov/opub/btn/volume-2/paid-leave-in-private-industry-over-the-past-20-years.htm).
and 42 percent fewer average watts under load than did the legacy desktop tower. Figure 3 shows the power usage of all three systems while idle and under load.

**Figure 3:** The average number of watts each system consumed while idle and under load. Lower numbers are better.

![Increase power efficiency with new desktops](chart)

As Figure 4 shows, replacing older inefficient desktops can significantly affect the bottom line. For example, a business replacing 10,000 legacy desktop towers with 10,000 new Mini Desktops could realize significant savings over four years—$7.65 saved annually per employee would add up to $306,000 total savings in power costs.³

**Figure 4:** Power consumption savings in dollars over four years when replacing a fleet of legacy desktop towers with Mini Desktops.

³ Based on a conservative estimate of one hour under load and seven hours idle for average power consumption per employee per day, 46-week work year per employee, and average US commercial power costs of $0.1075 per kilowatt-hour from the U.S. Energy Information Administration (www.eia.gov/electricity/monthly/pdf/epm.pdf).
MAKE IT STAFF MORE EFFECTIVE AND KEEP BUSINESS RUNNING

Lower repair costs and reduce employee downtime with out-of-band support

Replacing desktops can also enable IT to lower costs, reduce employee downtime, and support more systems. The All-in-One PC and Mini Desktop in our study included the latest Intel vPro™ technology and the latest version of Intel Active Management Technology (Intel AMT).4 The legacy desktop tower in our study shipped with an older release of Intel AMT (5.2), which meant that it did not support hardware-based Keyboard-Video-Mouse (KVM) Remote Control.5

With a fleet of new All-in-One PCs or Mini Desktops, your IT staff can access the graphical user interface (GUI) and control desktops remotely—regardless of power state. For non-operational desktops that are out-of-band, IT staff can resolve some problems remotely that previously would have required an expensive deskside visit with a fleet of legacy desktop towers. The travel time for deskside visits with legacy desktop towers ultimately increases the cost for IT to make repairs and increases the amount of employee downtime and lost productivity. In our testing, it took only 15 seconds to launch a KVM session on either the All-in-One PC or Mini Desktop, which translates to significantly less overhead for your IT staff.

The ability to use KVM Remote Control to support non-operational systems provides the following advantages for your IT:

- **Fewer truck rolls to remote sites** – IT can spend less time behind the wheel. For example, MSPs have reported a 90 percent reduction in deskside visits per month to a typical customer when they use KVM Remote Control to support Intel vPro systems.6
- **Reduce time to fix non-operational systems** – IT can diagnose and fix non-operational systems more quickly using KVM Remote Control, which can mean more time for other tasks.
- **Fix hardware problems in one visit instead of two** – IT can diagnose problems with KVM Remote Control and deploy a technician with parts, rather than one visit for diagnosis and a second visit to make the repair.
- **Reduce downtime for your employees** – Faster problem resolution ultimately means less lost productivity with less downtime for your employees.

Figures 5 through 8 illustrate potential savings for your business with a single support call for a non-operational system. In this scenario, an employee at a remote site calls the help desk to report a problem with her desktop, which is non-operational with

---

6 Based on field testing: [msp.intel.com/assets/CircleComputerResourcesCS.pdf](http://msp.intel.com/assets/CircleComputerResourcesCS.pdf)
a critical failure; IT would need 10 minutes to resolve the problem with KVM Remote Control session or a deskside visit.

Figure 5 illustrates the potential savings for employee downtime with the All-in-One PC or Mini Desktop. With the legacy desktop tower in this scenario, the employee would have to wait until the following business day for a deskside visit, representing eight business hours of downtime after the initial call. With the All-in-One PC and Mini Desktop, the employee would have to wait only 15 seconds for IT to initiate the KVM Remote Control session.\(^7\) In this scenario, replacing desktops would enable IT to reduce employee downtime by almost eight business hours for a single repair.

Replacing desktops would enable IT to reduce employee downtime significantly when supporting non-operational systems like the one in our scenario. Instead of waiting eight business hours for the repair, employees would be able to get back to work much sooner with a faster resolution of the critical software problem. Figure 6 shows the value of the reduced employee downtime with the All-in-One PC or Mini Desktop. The All-in-One PC or Mini Desktop would reduce the cost of employee downtime by $215.08 for the 10-minute software repair—a savings of nearly 98 percent.\(^8\)

---

\(^7\) We assumed an equal amount of time for IT to generate the support ticket with KVM Remote Control and the deskside visit, and did not include that time in our analysis. We also assumed that the employee was unproductive while IT staff completed the repair.

\(^8\) We estimated an average end-user cost of $0.4483 per minute, based on an average annual total compensation of $55,954.00, which includes an average 2013 US salary of $43,041.39 (www.ssa.gov/OACT/COLA/AWI.html) plus 30 percent in benefits.
Figure 6: Cost of lost productivity due to employee downtime with a non-operational system, in US dollars. Lower numbers are better.

Figure 7 illustrates the potential savings for IT labor with the All-in-One PC or Mini Desktop. With the legacy desktop tower in this scenario, IT would see significantly more overhead with one hour of total travel time to and from the remote site for the deskside visit. With the All-in-One PC or Mini Desktop, IT would have only 15 seconds of overhead equal to the time it would take to initiate the KVM Remote Control session. Replacing desktops would enable IT to reduce the time required to complete the repair by almost one hour in this scenario.

Figure 7: IT labor to repair a non-operational system, in hours. Lower numbers are better.
Reducing the amount of time IT staff need to repair non-operational systems can enable IT to support more systems and complete other tasks. Figure 8 shows the value of the time IT could save by replacing legacy desktop towers with new desktops. The 10-minute software repair would cost $39.65 less with the All-in-One PC or Mini Desktop due to the elimination of travel time—a cost savings of 85 percent.\(^9\)

Figure 8: Cost of IT labor to repair a non-operational system, in US dollars. Lower numbers are better.

**Lower costs with reduced IT labor by replacing desktops**

Cost of IT staff labor for a repair

- All-in-One PC and Mini Desktop with KVM Remote Control: $6.80
- Legacy Desktop Tower with deskside visit: $46.45

Dollars (US)

Reduce repair costs

An aging desktop fleet ultimately means that your IT staff and employees are using systems that are less reliable. Compared to new desktops, IT can spend more time to support or repair the aging systems and users can see more downtime.

We looked at several studies that compared repair rates for older and newer systems. They showed different failure rates in specific years, but they all suggested that costs trend upwards as systems age, indicating that businesses could see lower repair rates and costs for the All-in-One PC and Mini Desktop compared to our legacy desktop tower. For example, an Intel TCO analysis shows desktop failure rates of just 3 percent in the year three of ownership, 10 percent in year four, and 18 percent in year five.

Older systems like the legacy desktop tower can add more repair costs when they happen outside the original three-to-five year OEM warranty period. Once older systems are out of warranty, businesses can assume repairs internally or purchase out-of-warranty coverage from the OEM or a third party—both at a cost. Internal repairs add costs for parts, desktop support staff to diagnose and repair problems, and parts.

\(^9\) We estimated an IT cost of $.6635 per minute, based on an average annual total compensation estimate from Salary.com of $82,809 for a Help Desk Support senior-level position.
inventory management. Dell estimates that a service repair not covered by warranty can cost between $150 and $699.\(^\text{10}\) Much of the cost for out-of-warranty repairs comes from parts—a replacement hard drive for the legacy desktop tower could cost $90 or more,\(^\text{11}\) and costs to replace multiple parts on a system can exceed $600.\(^\text{12}\)

The alternative of extending warranty coverage from the vendor would add $119 per year per system for the legacy desktop tower in this study.\(^\text{13}\) Extended warranties, however, are ultimately an imperfect solution. Some vendors limit extended coverage to within the first three to five years from the date of purchase, and might not provide coverage for a legacy system the age of the one we studied.\(^\text{14}\) Extended warranties also do not cover all repair costs, leaving businesses to pay for some costs out of pocket. For example, parts coverage in the extended warranty for the legacy desktop tower in our study “is limited to one major part per product per 12-month period commencing from the Care Pack start date.”\(^\text{15}\)

**LEVERAGE THE NEWEST TECHNOLOGY**

**Gain the benefits of touch**

Touch-interactive technology is becoming as popular in the office as it is at home. An Intel study shows respondents overwhelmingly preferred laptops with touch,\(^\text{16}\) and shipments of touchscreen monitors are seeing growth.\(^\text{17}\)

Microsoft® Windows® 8.1 does not require touch technology, but a touch-enabled version of the operating system can allow users to access information, collaborate, and make presentations through quick touch gestures. For the All-in-One PC with the included touchscreen display, users can engage content such as Web pages, images, videos, pdfs, and email with touch-enabled apps such as Microsoft Office 365™, and then switch to the keyboard and mouse for typing and editing content, choosing the more comfortable interface for each task.

---

\(^{10}\) [www.dell.com/content/topics/segtopic.aspx?c=us&l=en&cs=19](www.dell.com/content/topics/segtopic.aspx?c=us&l=en&cs=19)

\(^{11}\) Based on the price of an individual drive of the model on the legacy desktop tower [www.newegg.com/Product/Product.aspx?Item=9SIA67S2G40001](www.newegg.com/Product/Product.aspx?Item=9SIA67S2G40001)


\(^{13}\) Cost for HP 1y PW 4h 9x5 LE-Desktop CPU HW Support - LE-Desktop CPU Only onsite response, 8am-5pm - standard business days excluding HP holidays [h30094.www3.hp.com/product/sku/2551404/mfg_partno/U4858PE](h30094.www3.hp.com/product/sku/2551404/mfg_partno/U4858PE)


For the All-in-One PC that we tested, the touch-enabled display added $186 to the starting price over a similarly configured model without touch.\textsuperscript{18} If the touchscreen on the All-in-One PC can deliver a productivity benefit of just one minute per day, the optional touch capability could pay back its added cost in under 20 months.\textsuperscript{19, 20}

**Connect via USB 3.0, DisplayPort, HDMI, and Wireless AC**

Replacing desktops can enable your business to take advantage of the latest USB technology. The All-in-One PC and Mini Desktop included USB 3.0 ports—eight and six, respectively. The legacy desktop tower offered USB 2.0 ports. USB 3.0 ports, such as those on the two Intel processor-powered desktops, can provide up to 4.8 Gbps transfer rates to USB 3.0 devices—up to 10 times faster than the transfer rate for USB 2.0 connections to USB 2.0 devices that you could get with the legacy desktop tower.

Replacing desktops can also bring the latest display technology to your business. In addition to the touchscreen display on the All-in-One PC, both the All-in-One PC and Mini Desktop included DisplayPort, which can support higher performance and lower power monitor displays than the legacy desktop tower we tested. The All-in-One PC also offered HDMI—either DisplayPort or HDMI on the All-in-One PC can be used to add a second display.

Replacing desktops can also boost your business with the latest in wireless technology. The All-in-One PC and Mini Desktop both included Intel Dual Band Wireless-AC 7260 cards, while the legacy desktop tower we tested did not include a wireless card. Replacing a fleet of legacy desktop towers without wireless cards provides more flexibility by removing the requirement of an Ethernet port and cable for each desktop.

**Save workspace with All-in-One and Mini form factors**

New desktops are available with the latest Intel technology in improved form factors that take up less workspace than big desktop towers. As Figure 9 shows, the All-in-One PC and Mini Desktop required significantly less workspace than the legacy desktop tower in our study—59 and 60 percent less square inches, respectively. Note: For more details on how we calculated workspace for the three systems, see Appendix C.

\textsuperscript{18} The starting price ($1,598) + three-year ProSupport Service brought the price to $1,677.57 for non-touch-enabled display with Intel Core i5 processor and 8 GB memory for the All-in-One PC. The starting price (including three-year ProSupport Service) for the All-in-One PC with the same processor and memory and touch-enabled display was $1,863.29 via www.dell.com/us/business/p/optiplex-9030-aio/fs?pf=v on 12/19/2014.

\textsuperscript{19} A minute a day, valued at $9.72 ($350/36), per month could provide payback for a $186 cost in 19.1 months.

\textsuperscript{20} Note: We tested the All-in-One PC installed with Windows 7 so that system configuration matched closely to the legacy desktop tower. The All-in-One PC and Mini Desktop are available with either Windows 7 or Windows 8.1.
As Figure 10 shows, the workspace savings that replacing desktops can bring your business can have an enormous impact at scale. For example, a business replacing 10,000 legacy desktop towers with 10,000 new Mini Desktops could save 7,708 sq. ft. of valuable workspace.

**CONCLUSION**

Replacing an aging desktop fleet is an important investment in your business. Faster and more reliable systems that offer the latest technology provide your employees an opportunity to be more productive with less waiting while they work. New desktops also benefit your IT staff, with significantly lower power costs and support for out-of-band management to reduce costly deskside visits.
# APPENDIX A – SYSTEM CONFIGURATION INFORMATION

Figure 11 details the systems we used in our tests.

<table>
<thead>
<tr>
<th>System</th>
<th>All-in-One PC</th>
<th>Mini Desktop</th>
<th>Legacy Desktop Tower</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number of processor packages</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Number of cores per processor</td>
<td>4</td>
<td>4</td>
<td>2</td>
</tr>
<tr>
<td>Number of hardware threads per core</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Total number of processor threads in system</td>
<td>4</td>
<td>4</td>
<td>2</td>
</tr>
<tr>
<td>System power management policy</td>
<td>Balanced</td>
<td>Balanced</td>
<td>Balanced</td>
</tr>
<tr>
<td>Processor power-saving option</td>
<td>EIST</td>
<td>EIST</td>
<td>EIST</td>
</tr>
<tr>
<td>Dimensions (h x l x w in inches)</td>
<td>20.50 x 22.25 x 8.50</td>
<td>1.50 x 7.38 x 7.19</td>
<td>17.63 x 17.38 x 7.00</td>
</tr>
<tr>
<td>Weight (lbs.)</td>
<td>24.1</td>
<td>2.5</td>
<td>23.8</td>
</tr>
<tr>
<td><strong>CPU</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor</td>
<td>Intel</td>
<td>Intel</td>
<td>Intel</td>
</tr>
<tr>
<td>Name</td>
<td>Core™ i5</td>
<td>Core i5</td>
<td>Core 2 Duo</td>
</tr>
<tr>
<td>Model number</td>
<td>4590S</td>
<td>4590T</td>
<td>E8400</td>
</tr>
<tr>
<td>Stepping</td>
<td>C0</td>
<td>C0</td>
<td>E0</td>
</tr>
<tr>
<td>Socket type</td>
<td>Socket 1150 LGA</td>
<td>Socket 1150 LGA</td>
<td>Socket 775 LGA</td>
</tr>
<tr>
<td>Core frequency (GHz)</td>
<td>3.0 / 3.7 Turbo</td>
<td>2.0 / 3.0 Turbo</td>
<td>3.0</td>
</tr>
<tr>
<td>Bus frequency</td>
<td>DMI2 5 GT/s</td>
<td>DMI2 5 GT/s</td>
<td>1,333 MHz</td>
</tr>
<tr>
<td>L1 cache</td>
<td>4 x 32 KB + 4 x 32 KB</td>
<td>4 x 32 KB + 4 x 32 KB</td>
<td>2 x 32 KB + 2 x 32 KB</td>
</tr>
<tr>
<td>L2 cache</td>
<td>4 x 256 KB</td>
<td>4 x 256 KB</td>
<td>6 MB</td>
</tr>
<tr>
<td>L3 cache</td>
<td>6 MB</td>
<td>6 MB</td>
<td>N/A</td>
</tr>
<tr>
<td><strong>Platform</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor and system name</td>
<td>Dell™ OptiPlex™ 9030 All-in-One</td>
<td>Dell OptiPlex 9020 Micro</td>
<td>HP Compaq 8000 Elite Convertible Minitower</td>
</tr>
<tr>
<td>Motherboard model number</td>
<td>0VNGWR</td>
<td>0Y5DDC</td>
<td>3647h</td>
</tr>
<tr>
<td>Motherboard chipset</td>
<td>Intel Q87</td>
<td>Intel Q87</td>
<td>Intel Q45/Q43</td>
</tr>
<tr>
<td>BIOS name and version</td>
<td>Dell A03 (09/15/2014)</td>
<td>Dell A02 (08/11/2014)</td>
<td>Hewlett-Packard 786G7 v01.13 (07/20/2011)</td>
</tr>
<tr>
<td>AMT Version</td>
<td>5.2.50</td>
<td>9.1.0</td>
<td>9.1.0</td>
</tr>
<tr>
<td>System</td>
<td>All-in-One PC</td>
<td>Mini Desktop</td>
<td>Legacy Desktop Tower</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>--------------------------------</td>
<td>-------------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td><strong>Memory module(s)</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>Samsung® M471B5173DB0-YK0</td>
<td>Hyundai Electronics HMT41GS6BFR8A-PB</td>
<td>Samsung M378B5673EH1-CH9</td>
</tr>
<tr>
<td>Type</td>
<td>PC3-12800</td>
<td>PC3-12800</td>
<td>PC3-10600</td>
</tr>
<tr>
<td>Speed (MHz)</td>
<td>1,600</td>
<td>1,600</td>
<td>1,333</td>
</tr>
<tr>
<td>Speed running in the system (MHz)</td>
<td>1,600</td>
<td>1,600</td>
<td>1,066</td>
</tr>
<tr>
<td>Timing/Latency (tCL-tRCD-tRP-tRASmin)</td>
<td>11-11-11-28</td>
<td>11-11-11-28</td>
<td>7-7-7-20</td>
</tr>
<tr>
<td>Size (MB)</td>
<td>4,096</td>
<td>8,192</td>
<td>2,048</td>
</tr>
<tr>
<td>Number of memory module(s)</td>
<td>2</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>Total amount of system RAM (GB)</td>
<td>8</td>
<td>8</td>
<td>4</td>
</tr>
<tr>
<td>Channel (single/dual)</td>
<td>Dual</td>
<td>Single</td>
<td>Dual</td>
</tr>
<tr>
<td><strong>Hard disk</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>Seagate® ST500LT012</td>
<td>Samsung PM851 SSD</td>
<td>Seagate ST3320418AS</td>
</tr>
<tr>
<td>Number of disks in system</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Size (GB)</td>
<td>500</td>
<td>128</td>
<td>320</td>
</tr>
<tr>
<td>Buffer size (MB)</td>
<td>16</td>
<td>N/A</td>
<td>16</td>
</tr>
<tr>
<td>RPM</td>
<td>5,400</td>
<td>N/A</td>
<td>7,200</td>
</tr>
<tr>
<td>Type</td>
<td>SATA 6.0 Gb/s</td>
<td>SATA 6.0 Gb/s</td>
<td>SATA 3.0 Gb/s</td>
</tr>
<tr>
<td>Controller</td>
<td>Intel 8 Series/C220 Chipset Family SATA AHCI</td>
<td>Intel 8 Series/C220 Chipset Family SATA AHCI</td>
<td>Intel Express Chipset SATA RAID Controller</td>
</tr>
<tr>
<td>Driver</td>
<td>Intel 12.8.7.1000 (10/18/2013)</td>
<td>Intel 13.0.0.1098 (02/05/2014)</td>
<td>Intel 10.1.0.1008 (11/06/2010)</td>
</tr>
<tr>
<td><strong>Operating system</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Windows 7 Professional x64</td>
<td>Windows 7 Professional x64</td>
<td>Windows 7 Professional x64</td>
</tr>
<tr>
<td>Build number</td>
<td>7600</td>
<td>7600</td>
<td>7600</td>
</tr>
<tr>
<td>Service Pack</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>File system</td>
<td>NTFS</td>
<td>NTFS</td>
<td>NTFS</td>
</tr>
<tr>
<td>Kernel</td>
<td>ACPI x64-based PC</td>
<td>ACPI x64-based PC</td>
<td>ACPI x64-based PC</td>
</tr>
<tr>
<td>Language</td>
<td>English</td>
<td>English</td>
<td>English</td>
</tr>
<tr>
<td>Microsoft DirectX® version</td>
<td>11</td>
<td>11</td>
<td>11</td>
</tr>
<tr>
<td>System</td>
<td>All-in-One PC</td>
<td>Mini Desktop</td>
<td>Legacy Desktop Tower</td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------------------------------------------</td>
<td>-------------------------------------------</td>
<td>-------------------------------------------</td>
</tr>
<tr>
<td><strong>Graphics</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>Intel HD Graphics 4600</td>
<td>Intel HD Graphics 4600</td>
<td>Intel GMA 4500</td>
</tr>
<tr>
<td>Type</td>
<td>Integrated</td>
<td>Integrated</td>
<td>Integrated</td>
</tr>
<tr>
<td>Chipset</td>
<td>Intel HD Graphics Family</td>
<td>Intel HD Graphics Family</td>
<td>Intel 4 Series Express Chipset Family</td>
</tr>
<tr>
<td>BIOS version</td>
<td>2179.5</td>
<td>2179.1</td>
<td>2066.0</td>
</tr>
<tr>
<td>Total available graphics memory (MB)</td>
<td>1,696</td>
<td>1,696</td>
<td>1,695</td>
</tr>
<tr>
<td>Dedicated video memory (MB)</td>
<td>64</td>
<td>64</td>
<td>64</td>
</tr>
<tr>
<td>System video memory (MB)</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Shared system memory (MB)</td>
<td>1,632</td>
<td>1,632</td>
<td>1,631</td>
</tr>
<tr>
<td>Resolution</td>
<td>$1,920 \times 1,080$</td>
<td>$1,920 \times 1,080$</td>
<td>$1,920 \times 1,080$</td>
</tr>
<tr>
<td>Driver</td>
<td>Intel 10.18.10.3412 (01/29/2014)</td>
<td>Intel 10.18.10.3412 (01/29/2014)</td>
<td>Intel 8.15.10.2413 (06/03/2011)</td>
</tr>
<tr>
<td><strong>Sound card/subsystem</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>Realtek® High Definition Audio</td>
<td>Realtek High Definition Audio</td>
<td>Realtek High Definition Audio</td>
</tr>
<tr>
<td><strong>Ethernet</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>Intel Ethernet Connection I217-LM</td>
<td>Intel Ethernet Connection I217-LM</td>
<td>Intel 82567LM-3 Gigabit Controller</td>
</tr>
<tr>
<td><strong>Wireless</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>Intel Dual Band Wireless-AC 7260</td>
<td>Intel Dual Band Wireless-AC 7260</td>
<td>N/A</td>
</tr>
<tr>
<td>Driver</td>
<td>Intel 17.0.5.8 (06/18/2014)</td>
<td>Intel 17.0.5.8 (06/18/2014)</td>
<td>N/A</td>
</tr>
<tr>
<td><strong>Optical drive(s)</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>TSSTcorp SU-208FB</td>
<td>N/A</td>
<td>HP TS-H653R</td>
</tr>
<tr>
<td>Type</td>
<td>DVD-RW</td>
<td>N/A</td>
<td>DVD-RW</td>
</tr>
<tr>
<td><strong>USB ports</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number</td>
<td>8</td>
<td>6</td>
<td>10</td>
</tr>
<tr>
<td>Type</td>
<td>3.0</td>
<td>3.0</td>
<td>2.0</td>
</tr>
<tr>
<td>Other</td>
<td>Media card reader, DisplayPort, 1 × HDMI In, 1 × HDMI Out</td>
<td>DisplayPort</td>
<td>N/A</td>
</tr>
</tbody>
</table>
Change your desktops, change your business

<table>
<thead>
<tr>
<th>Monitor</th>
<th>All-in-One PC</th>
<th>Mini Desktop</th>
<th>Legacy Desktop Tower</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model</td>
<td>Dell All-in-One Touch Display</td>
<td>Dell P2314H</td>
<td>ViewSonic® VG730m</td>
</tr>
<tr>
<td>LCD type</td>
<td>Backlit LED</td>
<td>Backlit LED</td>
<td>SXGA LCD</td>
</tr>
<tr>
<td>Screen size</td>
<td>23”</td>
<td>23”</td>
<td>17”</td>
</tr>
<tr>
<td>Refresh rate (Hz)</td>
<td>60</td>
<td>60</td>
<td>60</td>
</tr>
<tr>
<td>Maximum resolution</td>
<td>1,920 × 1,080</td>
<td>1,920 × 1,080</td>
<td>1,280 × 1,024</td>
</tr>
</tbody>
</table>

Figure 11: Detailed information for our test systems.

Figure 12 describes the configuration of the server that we used to access the desktops for management tasks.

<table>
<thead>
<tr>
<th>System</th>
<th>Dell PowerEdge R620</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power supplies</td>
<td></td>
</tr>
<tr>
<td>Total number</td>
<td>2</td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>Dell D750E-S1</td>
</tr>
<tr>
<td>Wattage of each (W)</td>
<td>750</td>
</tr>
<tr>
<td>Cooling fans</td>
<td></td>
</tr>
<tr>
<td>Total number</td>
<td>7</td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>Delta® GFC0412DS</td>
</tr>
<tr>
<td>Dimensions (h × w) of each</td>
<td>1-1/2” × 1-3/4”</td>
</tr>
<tr>
<td>Volts</td>
<td>12</td>
</tr>
<tr>
<td>Amps</td>
<td>1.82</td>
</tr>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>Number of processor packages</td>
<td>2</td>
</tr>
<tr>
<td>Number of cores per processor</td>
<td>8</td>
</tr>
<tr>
<td>Number of hardware threads per core</td>
<td>2</td>
</tr>
<tr>
<td>System power management policy</td>
<td>Default</td>
</tr>
<tr>
<td>CPU</td>
<td></td>
</tr>
<tr>
<td>Vendor</td>
<td>Intel</td>
</tr>
<tr>
<td>Name</td>
<td>Xeon®</td>
</tr>
<tr>
<td>Model number</td>
<td>E5-2660</td>
</tr>
<tr>
<td>Socket type</td>
<td>LGA 2011</td>
</tr>
<tr>
<td>Core frequency (GHz)</td>
<td>2.20</td>
</tr>
<tr>
<td>Bus frequency</td>
<td>8</td>
</tr>
<tr>
<td>L1 cache</td>
<td>32 KB + 32 KB (per core)</td>
</tr>
<tr>
<td>L2 cache</td>
<td>256 KB (per core)</td>
</tr>
<tr>
<td>L3 cache</td>
<td>20 MB</td>
</tr>
<tr>
<td>Platform</td>
<td></td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>Dell PowerEdge™ R620</td>
</tr>
<tr>
<td>BIOS name and version</td>
<td>Dell 2.4.3 (10/10/2014)</td>
</tr>
<tr>
<td>BIOS settings</td>
<td>Default</td>
</tr>
<tr>
<td><strong>System</strong></td>
<td><strong>Dell PowerEdge R620</strong></td>
</tr>
<tr>
<td>------------</td>
<td>------------------------</td>
</tr>
<tr>
<td><strong>Memory module(s)</strong></td>
<td></td>
</tr>
<tr>
<td>Total RAM in system (GB)</td>
<td>128</td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>Micron® MT36KSF1G72PZ</td>
</tr>
<tr>
<td>Type</td>
<td>PC3-12800R</td>
</tr>
<tr>
<td>Speed (MHz)</td>
<td>1,600</td>
</tr>
<tr>
<td>Speed running in the system (MHz)</td>
<td>1,600</td>
</tr>
<tr>
<td>Timing/Latency (tCL-tRCD-tRP-tRASmin)</td>
<td>9-9-9-24</td>
</tr>
<tr>
<td>Size (GB)</td>
<td>8</td>
</tr>
<tr>
<td>Number of RAM module(s)</td>
<td>20</td>
</tr>
<tr>
<td>Chip organization</td>
<td>Double-sided</td>
</tr>
<tr>
<td>Rank</td>
<td>Dual</td>
</tr>
<tr>
<td><strong>Operating system</strong></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Microsoft Windows Server® 2012 R2 Datacenter</td>
</tr>
<tr>
<td>Build number</td>
<td>9600</td>
</tr>
<tr>
<td>File system</td>
<td>NTFS</td>
</tr>
<tr>
<td>Kernel</td>
<td>6.2.9600.16452</td>
</tr>
<tr>
<td>Language</td>
<td>English</td>
</tr>
<tr>
<td><strong>RAID controller</strong></td>
<td></td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>Dell PERC H710P Mini</td>
</tr>
<tr>
<td>Firmware version</td>
<td>21.3.1-0009 06/23/2014</td>
</tr>
<tr>
<td>Driver version</td>
<td>6.802.21.00 08/27/2014</td>
</tr>
<tr>
<td>Cache size (MB)</td>
<td>1,024</td>
</tr>
<tr>
<td><strong>Local storage</strong></td>
<td></td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>Seagate ST9900806SS</td>
</tr>
<tr>
<td>Number of drives</td>
<td>4</td>
</tr>
<tr>
<td>Size (GB)</td>
<td>900</td>
</tr>
<tr>
<td>RPM</td>
<td>10K</td>
</tr>
<tr>
<td>Type</td>
<td>SAS</td>
</tr>
<tr>
<td><strong>Ethernet adapters</strong></td>
<td></td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>Intel Gigabit I350 4-port</td>
</tr>
<tr>
<td>Type</td>
<td>Integrated</td>
</tr>
<tr>
<td>Driver</td>
<td>12.11.97.1 (08/13/2014)</td>
</tr>
<tr>
<td>USB 2.0 ports</td>
<td>4</td>
</tr>
</tbody>
</table>

*Figure 12: Detailed information for our test server.*
We included the following benchmarks in our performance/productivity calculation:

- HDXPRT 2012
- PCMark® 8 Work workload
- SYSmark® 2014
- 3DMark® Ice Storm
- 3DMark Ice Storm Extreme

We ran the five benchmarks on the All-in-One PC, Mini Desktop, and legacy desktop tower, repeating each test three times. For our calculations, we selected the median of the three results for each benchmark and system. We calculated the percentage wins for the All-in-One PC and Mini Desktop versus the legacy desktop tower on each benchmark. The All-in-One PC and Mini Desktop outperformed the legacy desktop tower on all five benchmarks.

We calculated system performance by taking the geometric mean of the percentage wins; that gave us a 145.3 percent system performance improvement for the All-in-One PC versus the legacy desktop and a 114.1 percent system performance improvement for the Mini Desktop (see Figure 13).

<table>
<thead>
<tr>
<th></th>
<th>All-in-One PC</th>
<th>Mini Desktop</th>
<th>Legacy Desktop Tower</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Score</strong></td>
<td>229</td>
<td>193</td>
<td>100</td>
</tr>
<tr>
<td><strong>% improvement over legacy desktop tower</strong></td>
<td>129%</td>
<td>93%</td>
<td></td>
</tr>
<tr>
<td>HDXPRT (Create HD score)</td>
<td>1,417</td>
<td>1,334</td>
<td>607</td>
</tr>
<tr>
<td><strong>% improvement over legacy desktop tower</strong></td>
<td>133%</td>
<td>120%</td>
<td></td>
</tr>
<tr>
<td>SYSmark (Overall Rating)</td>
<td>3,015</td>
<td>3,093</td>
<td>2,341</td>
</tr>
<tr>
<td><strong>% improvement over legacy desktop tower</strong></td>
<td>29%</td>
<td>32%</td>
<td></td>
</tr>
<tr>
<td>PCMark (Work Score)</td>
<td>57,050</td>
<td>40,258</td>
<td>12,385</td>
</tr>
<tr>
<td><strong>% improvement over legacy desktop tower</strong></td>
<td>361%</td>
<td>225%</td>
<td></td>
</tr>
<tr>
<td>3DMark Ice Storm (Median)</td>
<td>34,812</td>
<td>25,834</td>
<td>7,566</td>
</tr>
<tr>
<td><strong>% improvement over legacy desktop tower</strong></td>
<td>360%</td>
<td>241%</td>
<td></td>
</tr>
</tbody>
</table>

**Geometric mean of percentage wins**

145.3%                      114.1%

*Figure 13: System performance improvement based on our benchmark testing.*
APPENDIX C – HOW WE CALCULATED WORKSPACE

Figure 14 shows the dimensions for the three systems and the workspace savings for the All-in-One PC and Mini Desktop. The base of the All-in-One PC was roughly the same size as the 9” circular base of the monitor that we paired with the legacy desktop tower. The legacy desktop tower chassis (17.6” × 17.4” × 7.0”) took up 121.7 square inches of desk space. The circular base of the monitor added 63.6 square inches, for a total footprint of 185.3 square inches. With a footprint of 76.5 square inches, the All-in-One PC was 108.8 square inches smaller than the legacy desktop tower—a savings of 59 percent.

The Mini Desktop chassis (1.5” × 7.4” × 7.2”) took up 11.1 square inches of desk space. We used monitors with similar footprints for the Mini Desktop (62.2 square inches) and the legacy desktop tower (63.6 squares inches). Including the monitors, the footprint of the Mini Desktop was 111.0 square inches smaller than the footprint of the legacy desktop tower—a savings of 60 percent.

<table>
<thead>
<tr>
<th>Monitor System</th>
<th>Monitor Area (sq. inches)</th>
<th>System Length × width (inches)</th>
<th>System Area (sq. inches)</th>
<th>Total Area (sq. inches)</th>
<th>Advantage vs. legacy (sq. inches)</th>
<th>Advantage (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>All-in-One PC</td>
<td>8.5 × 9.0</td>
<td>76.5</td>
<td></td>
<td>76.5</td>
<td>108.8</td>
<td>59%</td>
</tr>
<tr>
<td>Mini Desktop (on its narrow side)</td>
<td>7.1 × 8.9</td>
<td>63.2</td>
<td>7.4 × 1.5</td>
<td>11.1</td>
<td>74.3</td>
<td>111.0</td>
</tr>
<tr>
<td>Legacy Desktop Tower (circular base)</td>
<td>9.0</td>
<td>63.6</td>
<td>17.4 × 7</td>
<td>121.7</td>
<td>185.3</td>
<td></td>
</tr>
</tbody>
</table>

Figure 14: Dimensions of the three systems and the workspace savings for the All-in-One PC and Mini Desktop.
APPENDIX D – HOW WE TESTED

Measuring system performance

HDXPRT 2012

Setting up the test
1. Insert the HDXPRT v1.1 DVD-ROM into your DVD drive.
2. At the HDXPRT Install screen, click Install HDXPRT.
3. Accept the HDXPRT end-user license agreement.
4. After the setup is complete, select Yes, I want to restart my computer now, and click Finish.

Running the test
1. On the desktop, click the HDXPRT 2012 shortcut.
2. Click Run HDXPRT.
3. Enter a test name, choose 3 iterations, and click Run.
4. The Results Screen automatically appears at the end of a successful run.

BAPCo® SYSmark 2014 v1.0.1.21

Antivirus software conflicts
SYSmark 2014 is not compatible with any virus-scanning software, so we uninstalled any such software that was present on the desktop PCs before we installed the benchmark.

Pre-installed software conflicts
SYSmark 2014 installs the following applications, which its test scripts employ:
- Adobe® Acrobat® XI Pro
- Adobe Photosho® CS6 Extended
- Adobe Premiere® Pro CS6
- Google Chrome™
- Microsoft Excel® 2013
- Microsoft OneNote® 2013
- Microsoft Outlook® 2013
- Microsoft PowerPoint® 2013
- Microsoft Word 2013
- Trimble® SketchUp® Pro 2013
- WinZip® Pro 17.5

Setting up the test
1. Disable the User Account Control.
2. Click Start → Control Panel.
3. At the User Accounts and Family Safety settings screen, click Add or remove user account.
4. At the User Account Control screen, click Continue.
5. Click Go to the main User Accounts page.
6. At the Make changes to your user account screen, click Turn User Account Control on or off.
7. At the User Account Control screen, click Continue.
8. Uncheck Use User Account Control to help protect your computer, and click OK.
9. At the You must restart your computer to apply these changes screen, click Restart Now.
11. To launch SYSmark 2014, double-click the desktop icon, and select Configuration.
12. Select all options, and click Save.

Running the test
1. Double-click the desktop icon to launch SYSmark 2014.
2. Make sure Office Productivity, Media Creation, and Data/Financial Analysis are selected.
3. Enter a Project name.
4. Select 3 Iterations, check the box beside Conditioning Run and beside Process Idle Tasks, and click Run Benchmark.
5. When the benchmark completes and the main SYSmark 2014 menu appears, click Save FDR to create a report.

Futuremark® PCMark 8 v2.3.293

Setting up the test
2. Double-click the PCMark installer exe file to install PCMark 8 with the default options.
3. Click the PCMark 8 desktop icon to launch PCMark 8. Enter the registration code, click Register, and click OK.
4. Exit PCMark 8.

Running the test
1. Boot the system and type CMD to bring up a command prompt.
2. To open App options, right-click the Command Prompt app.
3. Click Run as administrator.
4. Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks
5. Do not interact with the system until the command completes.
6. After the command completes, wait 5 minutes before running the test.
7. Double-click the PCMark 8 desktop icon to launch the benchmark.
8. Select the Home test suite.
9. Click Run Conventional.
10. When the benchmark run completes, record the results.
11. Shut down the system.
12. Complete steps 1 through 11 two more times for the Home test suite, and report the median of the three runs.
13. After completing the three runs of the Home test suite, perform steps 1 through 12 for the Creative, Work, Storage, and Application suites.

3DMark

Installing 3DMark v1.4.828
1. Download the 3DMark installer from www.futuremark.com/benchmarks/3dmark/all.
2. To install 3DMark with the default options, double-click the 3DMark installer exe file.
3. At the Welcome screen, click Next.
4. At the License Agreement screen, click I accept the terms of the license agreement, and click Next.
5. At the Setup Type screen, click Express, and click Next.
6. At the Ready to Install the Program screen, click Install.
7. At the Setup Complete screen, click Finish.
8. To launch 3DMark, double-click the 3DMark desktop icon. Enter the registration code, and click Register.

Running 3DMark v1.4.828
1. Boot the system and bring up a command prompt:
   a. Type CMD into the Start menu search bar.
   b. Right-click the Command Prompt app.
c. Click the Run as administrator button.
2. Type `Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks`
3. Do not interact with the system until the command completes.
4. After the command completes, wait 5 minutes before running the test.
5. To launch the benchmark, double-click the 3DMark desktop icon.
6. At the 3DMark Benchmark screen, click Run Ice Storm Unlimited.
7. When the benchmark run completes, record the results.
8. Repeat steps 6 and 7, except run Ice Storm Extreme.
9. Complete steps 1 through 8 two more times, and report the median of the three runs.

### Measuring power consumption

**Test requirements**
- ExTech 380801 True RMS Power Analyzer
- PassMark® BurnInTest Professional
- Thermometer

**Measuring system temperature while idle and under load**

**Setting up the test**
1. Using a power strip, plug the system under test (and monitor if used) into the ExTech.
2. Plug the ExTech into its own circuit.
3. On the system used to monitor the ExTech, open the Power Analyzer.
4. From the drop-down Option menu, select Sample Rate.
5. For the sample rate, enter 1.0, and select OK.
6. On the systems under test, set the power plan to the manufacturer’s default setting. Set the display brightness to 100 percent:
   a. Click Start.
   b. In the Start menu’s quick search field, type `Power Options`
   c. Move the Screen brightness slider all the way to the right.
7. Set the remaining power plan settings as follows:
   - Dim the display: Never
   - Turn off the display: Never
   - Put the computer to sleep: Never
8. Disable the screen saver.
10. To run setup, double-click `bitpro_x64.exe`.
11. At the Welcome screen, click Next.
12. Accept the license agreement, and click Next.
13. At the Choose Install Location screen, accept the default location of `C:\Program Files\BurnInTest`, and click Next.
14. At the Select Start Menu Folder screen, click Next.
15. At the Ready to Install screen, click Install.
16. At the Completing the BurnInTest Setup Wizard screen, deselect View Readme.txt, and click Finish to launch PerformanceTest.
17. At the Purchasing information screen, copy and paste the Username and key, and click Continue.
18. At the Key accepted screen, click OK.
19. From the Configuration menu item, select Test selection and duty cycles.
20. Change the Auto Stop After field to 180.
21. Select CPU, 2D Graphics, 3D Graphics, RAM, and Disk(s), and deselect all other subsystems.
22. Set load to 100, and click OK.
23. From the Configuration menu item, select Test Preferences and set or verify the following by clicking on each tab:
   • Disk: select C: drive
   • Logging: select Turn automatic logging on
   • 2D Graphics: select All available Video Memory
   • 3D Graphics: defaults
   • RAM: select Multi-Process Torture Test

Running the test
1. Boot the system and bring up an administrative command prompt:
2. Type `Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks`
3. Do not interact with the system until the command completes.
4. After the command completes, wait 5 minutes before running the test.
5. On the ExTech power monitor, enter a name for the test run.
6. Report the room temperature, and in the ExTech Power Analyzer window, click Start Recording
7. After 30 minutes, record the room temperature.
8. After 1 hour, record the room temperature and in the ExTech Power Analyzer window, click Stop Recording.
9. Record the average watts of the run as Idle Power consumption.
10. Record the average of the recorded room temperatures as the Idle Room Temperature.
11. On the ExTech power monitor, enter a name for the Under Load test run.
12. Double-click the PassMark BurnInTest desktop icon.
13. In the BurnInTest V7.0 Pro screen, click Start Selected Tests.
14. Report the room temperature, and in the ExTech Power Analyzer window, click Start Recording.
15. After 30 minutes, record the room temperature.
16. After 1 hour, record the room temperature, and in the ExTech Power Analyzer window, click Stop Recording.
17. Record the average watts of the run as Under Load Power Consumption.
18. Record the average of the recorded room temperature as the Under Load Room Temperature.
19. Power the system down and let it rest for one hour.
20. Complete steps 1 through 19 two more times, and report the median of the three Idle and Under Load runs as well as the average temperature for each median run.

Configuring the SCCM management environment
Starting from our base Microsoft System Center 2012 Configuration Manager build, we configured our environment to test KVM Remote Control capability on our target clients. Figure 15 shows our isolated testing environment, which comprised of one Dell PowerEdge R620 server running Windows Server 2008 R2 Hyper-V® with four virtual machines. Before configuration, we installed all available Windows updates on our clients and joined each desktop to the test.local domain. We created Active Directory accounts for AMT provisioning and installed Intel Setup and Configuration Software (Intel SCS). Next, we provisioned the desktops using Configurator, provided by Intel, to apply our custom management profile from SCS to each client’s management engine. We provide detailed steps below for each of these procedures. Finally, we installed vendor-specific vPro management tools, which we used to connect to the All-in-One PC and Mini Desktop using KVM Remote Control to complete our timed testing.
<table>
<thead>
<tr>
<th>Description</th>
<th>Computer name</th>
<th>Operating system</th>
<th>Roles Installed</th>
<th>Assigned IP</th>
<th>vCPU</th>
<th>vRAM</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domain controller</td>
<td>dc.test.local</td>
<td>Windows Server 2008 R2 Standard</td>
<td>Active Directory, Domain Controller, DHCP</td>
<td>192.168.1.10</td>
<td>1</td>
<td>8 GB</td>
</tr>
<tr>
<td>Certificate authority</td>
<td>ca.test.local</td>
<td>Windows Server 2008 R2 Enterprise</td>
<td>Certification Authority</td>
<td>192.168.1.15</td>
<td>1</td>
<td>8 GB</td>
</tr>
<tr>
<td>Database server</td>
<td>db.test.local</td>
<td>Windows Server 2008 R2 Standard</td>
<td>SQL Server 2012 Enterprise</td>
<td>192.168.1.20</td>
<td>1</td>
<td>16 GB</td>
</tr>
<tr>
<td>Management server</td>
<td>cm.test.local</td>
<td>Windows Server 2008 R2 Standard</td>
<td>System Center 2012 Configuration Manager SP1</td>
<td>192.168.1.50</td>
<td>2</td>
<td>16 GB</td>
</tr>
</tbody>
</table>

Figure 15: The details of our isolated testing environment.

Constructing the infrastructure

Creating Active Directory accounts for AMT provisioning
1. Log into the Domain Controller using the domain\administrator account.
2. Open Active Directory Administrative Center.
3. Under test\local, click New\Group.
4. On the Create Group window, for Group name, use Kerberos Admins; for Group type, use security.
5. Add Kerberos Admins as a member of the Domain Admins group.
6. Add the computer account of the SCCM server to the Kerberos Admins security group.
7. Create an Organizational Unit for AMT managed systems. We used AMT
8. Create a security group called AMT
9. Add the Kerberos Admins group to the AMT security group.

Creating certificate templates for OOB management
1. Log into the Windows 2008 R2 Enterprise server designated for Certificate Authority as domain\administrator.
2. Click Start\Administrative Tools\Certification Authority.
3. Right-click on test-CA-CA, and click Properties.
5. On the Details tab, scroll to and select Thumbprint. Copy the 40-character code displayed in the details. You will add this information to the AMT BIOS later.
6. To close the Certificate Authority properties, click OK.
7. Expand the Certification Authority, and select Certificate Templates.
8. Right-click Certificate Templates, and select Manage.
9. Locate Web Server in the list of available certificate templates. Right-click the template, and select Duplicate Template.
10. Select Windows 2003 Enterprise, and click OK.
11. Change the template name for the AMT Provisioning certificate. We used AMT Provisioning.
12. On the Subject Name tab, select Build from this Active Directory Information. Select Common Name, and choose the option UPN.
13. On the Security tab, add the security group created for the SCCM site server. We used the Kerberos Admin group. Add the Enroll permission for the security group. Ensure Domain Admins and Enterprise Admins have Enroll permissions.
15. Click Add. Click New. Type AMT Provisioning for the name, and 2.16.840.1.113741.1.2.3 as the Object Identifier. Click OK.
16. Ensure AMT Provisioning and Server Authentication are listed, and click OK.
17. Click OK to close the template properties.
18. Right-click the AMT Web Server Certificate template, and select Duplicate Template.
19. Select Windows 2003 Enterprise, and click OK.
20. Change the template name for the AMT Web Server Certificate. We used AMT Web Server Certificate Template.
22. On the Subject Name tab, select Supply in the request.
23. On the Security tab, ensure Domain Admins and Enterprise Admins have Enroll permissions.
24. To close the template properties, click OK.
25. In Certification Authority, navigate to Certificate Templates.
26. For both the AMT Provisioning Template, and the AMT Web Server Certificate Template, repeat the following steps:
27. Right-click the central panel, and select New Certificate Template to Issue.
28. Select the AMT Provisioning Template.
29. Click OK.
30. Log into the management server as domain\administrator.
31. Click Start→Run. Type mmc and press Enter.
32. In the mmc console, click File→Add/Remove Snap-in…
33. Select Certificates, and click Add. Select Computer account. Click Next.
34. Select Local computer, and click Finish.
35. Click OK.
36. Expand Certificates (Local Computer)→Personal→Certificates.
37. In the right panel, click More Actions→All Tasks→Request a new certificate…
38. Click Next.
39. Accept the defaults, and click Next.
40. Select the new AMT Provisioning certificate. Click Enroll.
41. Click File→Add/Remove Snap-in…
42. Select Certificates, and click Add. Select Computer account. Click Next.
43. Select My user account, and click Finish.
44. Click OK.
45. Expand Certificates→Personal→Certificates.
46. In the right panel, click More Actions→All Tasks→Request a new certificate…
47. Click Next.
48. Accept the defaults, and click Next.
49. Select the new AMT Provisioning certificate. Click Enroll.
50. Click File→Add/Remove Snap-in…
51. Select Certificates, and click Add. Select My user account. Click Next.
52. Select Local computer, and click Finish.
53. Click OK.
54. Expand Certificates→Current User→Personal→Certificates.
55. From Certificates (Local)→Personal→Certificates, click and drag the certificate created using the AMT Provisioning template into Certificates→Current User→Personal→Certificates.
56. Click Close.
Installing Intel Setup and Configuration Software (SCS) 9.1
2. Extract the contents to C:\IntelSCS_9.1.
3. Browse to C:\IntelSCS_9.1\IntelSCS\RCS.
4. Run IntelSCSInstaller.exe.
5. At the Welcome screen, click Next.
6. Select I accept the terms of the license agreement, and click Next.
7. Check the Boxes for Remote Configuration Service (RCS), Database Mode, and Console.
8. Enter the credentials of the Domain account that will run the service. We used test.local\administrator. Click Next.
9. Select db.test.local as the location for the SCS database. This information may populate automatically. Select Windows Authentication, and click Next.
10. On the Create Intel SCS Database pop-up, click Create Database.
11. On the confirmation screen, leave the default Installation Folder, and click Install.
12. Once the installation is complete, click Next.
13. Click Finish.

Setting up AMT provisioning with Intel SCS Remote Configuration Service

Creating the configuration profile
1. On the management server, launch the Intel Setup and Configuration Console.
2. Click Profiles.
3. To construct a profile for deployment, click New.
4. For Profile Name, enter a description of the target clients. We used inteltest. Click OK.
5. On the Getting Started Screen, choose Configuration / Reconfiguration.
6. On the Optional Settings screen, choose the options Active Directory Integration, Access Control List (ACL), and Transport Layer Security (TLS), and click Next.
7. On the AD Integration screen, browse for the OU created for the AMT managed devices. We used OU=AMT, DC=test, DC=local. Check the box for Always use host name, and click Next.
10. Add Kerberos Admin, Domain Admins, or other administrative users groups. Click OK.
11. For Access Type, select Remote.
12. Choose the option for PT Administration. Click OK.
13. Click Next.
14. On the TLS screen, from the drop-down menu, select the Enterprise Certificate Authority, ca.test.local.
15. Select the Server Certificate Template to be used to generate certificates for the AMT devices. We selected AMTWebServerCertificate. Click Next.
17. Select Use the following password for all systems. Enter the password for use after provisioning is complete. We used P@ssw0rd
18. Click KVM Settings...
19. Enter the RFB Password for KVM sessions. We used P@ssw0rd
20. Enter the MEBX password. We used P@ssw0rd
21. Uncheck User Consent required before beginning KVM session, and click OK.
22. Choose the options Enable Intel AMT to respond to ping requests and Enable Fast Call for Help (within the enterprise network).
23. To Edit IP and FQDN settings, click Set.
24. In the Network Settings window, select Use the following as the FQDN, and choose Primary DNS FQDN from the drop-down menu.
25. Choose the option, the device and the OS will have the same FQDN (Shared FQDN).
26. Select Get the IP from the DHCP server.
27. Select Update the DNS directly or via DHCP option 81. Click OK.
28. Click Next.
29. Click Finish.

Configuring the clients
Repeat these steps for each client.

Reserving an IP address in DHCP
2. Expand FQDN → IPv4 → Scope, and click Reservations.
3. Click More Actions, and click New Reservation.
4. For Reservation Name, enter the host name of the target client.
5. Enter an IP address to reserve.
6. Enter the MAC address of the target client’s Ethernet port.
7. Click Add.

Configuring policy on the target client
1. Log onto the target client using domain\administrator.
2. Download and apply applicable driver packages from the manufacturer’s Web site.
4. Click Firewall Properties.
5. On the Domain Profile, Private Profile, and Public Profile tabs, set the Firewall state to Off. Click OK.
6. Set the host name and IP of each virtual machine as described above.
7. Run lusrmgr.msc.
8. Select Groups.
10. Click Add.
11. Select Object Types, check the box for Computers, and click OK.
12. Disable the wireless adapter.

Configuring the Configuration Manager Client
1. On the management server, navigate to Program Files → Microsoft Configuration Manager folder.
2. Copy the Client folder to the target client.
3. On the target client, run ccmsetup.exe. This task will run in the background and will take a few minutes to complete.
4. In Control Panel, open Configuration Manager.
5. On the Site tab, click Configure Settings.
6. For Currently assigned to site code, enter PTL, and click Apply.
8. After a few minutes, the Actions panel will populate with more tasks. Run each one of the tasks.

Adding the enterprise certificate authority to the AMT trusted root certification authorities
1. Power on the target client.
2. During POST, press CTRL-P to enter the Intel Management Engine BIOS settings.
3. When prompted for a password, type the default password admin.
4. Provide and confirm a new password. We used P@ssw0rd
5. Select Intel AMT Configuration. Press Enter.
6. Select SOL/IDER/KVM.
7. All features should be Enabled. To exit the menu, press Esc.
8. Select User Consent.
10. Change Opt-in Configurable from Remote IT to Disabled. To exit the menu, press Esc.
11. Change Password Policy to During Setup and Configuration.
13. Select Intel ME Network Name Settings.
14. For Host Name, use the same host name used for the operating system.
15. For Domain Name, enter the domain name. We used test.local
16. For Shared/Dedicated FQDN, select Shared.
17. For Dynamic DNS Update, select Enabled. Press Esc to exit the menu.
19. On Provisioning Server IPv4/IPv6, enter the IP address of the system center server. We used 192.168.1.50
20. For Provisioning Server FQDN, enter the FQDN of the management server. We entered cm.test.local. For port number we used 9971
21. Select TLS PKI.
22. Select PKI DNS Suffix, and type the FQDN suffix. We used test.local. Press Enter.
23. Select Manage Hashes.
24. To add a new hash, press Insert.
25. Enter a descriptive name for the Enterprise Certificate Authority. We used test.local CA
26. Press Enter.
27. Following the syntax example provided in the prompt, enter the 40-character thumbprint previously copied from the Enterprise CA root certificate. Press Enter.
28. To set the hash certificate as active, press Y. test.local CA will appear in the list of trusted root authorities and should be active.
29. To return to the AMT Configuration Menu, press Esc.
30. Select Activate Network Access. To confirm, press Y.
31. To exit, press Esc until prompted. To confirm exit, press Y.

**Executing the remote configuration script on the AMT managed client**

1. Log into the AMT managed target client as domain\administrator.
2. Copy the \Configurator folder from the SCS_9.1 directory located on the management server to C:\ on the local host.
3. Open a command prompt as administrator.
4. Type `cd C:\Configurator` and press Enter.
5. Execute the following command:
   ```
   ACUConfig.exe /lowsecurity /output console /verbose ConfigViaRCSOnly cm.test.local inteltest
   ```
6. The Configurator utility will contact the Remote Configuration Service and apply the settings configured in the inteltest profile.

**Setting up AMT discovery in SCCM**

1. On the management server, open the SCCM Management Console. Locate the target client in the Devices panel.
2. Right-click the headings bar in the Devices panel, and check the entries for AMT Status and AMT Version.
3. Right-click the server, and select Manage Out of Band→Discover AMT Status. Click OK.
4. In the Home menu at the top of the panel, click Refresh.
5. The Client, Site Code, and Client Activity fields will populate. The AMT Status will change to Externally provisioned.

**Measuring the time to open a KVM session with the All-in-One PC and Mini Desktop**

1. On the management server, from the Windows taskbar, open Dell Command | Intel vPro Out of Band and start the timer.
2. Select Operations.
3. Select KVM Connect.
4. On the KVM Connect screen, select the target client, and click Connect.
5. The KVM window will appear and connect automatically. When the login screen is visible, stop the timer.
6. Complete steps 1 through 5 two more times, and report the median of the three runs.

**APPENDIX E – BENCHMARK INFORMATION**

**About HDXPRT 2012**

The High Definition Experience & Performance Ratings Test (HDXPRT) 2012 is a benchmark that evaluates the capabilities of PCs in consumer digital media uses, divided into the following categories:

- Media Organizer
- Media Creator
- Photo Blogger
- Video Producer
- Music Maker


**About BAPCo SYSmark 2014**

According to BAPCo, “SYSmark 2014 is an application-based benchmark that reflects usage patterns of business users in the areas of office productivity, media creation, and data/financial analysis.” The benchmark features notable applications from these fields. SYSmark 2014 generates a score from the times the tested system takes to complete each individual operation in each scenario. For more information on this benchmark, see bapco.com/products/sysmark-2014.

**About Futuremark PCMark 8 v2.2.282**

According to Futuremark, “PCMark 8 is the latest version in our series of industry standard PC-benchmarking tools.” PCMark 8 evaluates the performance of PCs from tablets to desktops by using real-world tasks and applications. Applications are divided into scenarios that reflect common usage in different capacities. For our testing, we used the Work portion of the benchmark, which offers workloads that test a system's ability to perform basic office work tasks, such as writing documents, browsing Web sites, creating spreadsheets, and using video chat.

**About Futuremark 3DMark (2013) v1.4.778**

Futuremark 3DMark v1.4.778 is a collection of benchmarks designed to rate the graphics performance of smartphones, tablets, notebooks, laptops, desktops, or high-performance gaming PCs. 3DMark includes benchmarks designed for Windows, Apple®, and Android™ devices. The Ice Storm portion of 3DMark includes 720p graphics tests to
measure GPU performance and a physics test to stress CPU performance. Ice Storm is available for Windows, iOS, and Android smart phones and tablets. It uses a DirectX® 11 feature level 9 for Windows and OpenGL® ES 2.0 for iOS and Android systems. Ice Storm Extreme increases the rendering resolution to 1080p and uses higher quality textures and post-processing effects in the Graphics tests.

For more information on 3DMark, see www.futuremark.com/benchmarks/3dmark.
ABOUT PRINCIPLED TECHNOLOGIES

We provide industry-leading technology assessment and fact-based marketing services. We bring to every assignment extensive experience with and expertise in all aspects of technology testing and analysis, from researching new technologies, to developing new methodologies, to testing with existing and new tools.

When the assessment is complete, we know how to present the results to a broad range of target audiences. We provide our clients with the materials they need, from market-focused data to use in their own collateral to custom sales aids, such as test reports, performance assessments, and white papers. Every document reflects the results of our trusted independent analysis.

We provide customized services that focus on our clients’ individual requirements. Whether the technology involves hardware, software, Web sites, or services, we offer the experience, expertise, and tools to help our clients assess how it will fare against its competition, its performance, its market readiness, and its quality and reliability.

Our founders, Mark L. Van Name and Bill Catchings, have worked together in technology assessment for over 20 years. As journalists, they published over a thousand articles on a wide array of technology subjects. They created and led the Ziff-Davis Benchmark Operation, which developed such industry-standard benchmarks as Ziff Davis Media’s Winstone and WebBench. They founded and led eTesting Labs, and after the acquisition of that company by Lionbridge Technologies were the head and CTO of VeriTest.

Principled Technologies is a registered trademark of Principled Technologies, Inc. All other product names are the trademarks of their respective owners.

Disclaimer of Warranties; Limitation of Liability:
PRINCIPLED TECHNOLOGIES, INC. HAS MADE REASONABLE EFFORTS TO ENSURE THE ACCURACY AND VALIDITY OF ITS TESTING, HOWEVER, PRINCIPLED TECHNOLOGIES, INC. SPECIFICALLY DISCLAIMS ANY WARRANTY, EXPRESSED OR IMPLIED, RELATING TO THE TEST RESULTS AND ANALYSIS, THEIR ACCURACY, COMPLETENESS OR QUALITY, INCLUDING ANY IMPLIED WARRANTY OF FITNESS FOR ANY PARTICULAR PURPOSE.

ALL PERSONS OR ENTITIES RELYING ON THE RESULTS OF ANY TESTING DO SO AT THEIR OWN RISK, AND AGREE THAT PRINCIPLED TECHNOLOGIES, INC., ITS EMPLOYEES AND ITS SUBCONTRACTORS SHALL HAVE NO LIABILITY WHATSOEVER FROM ANY CLAIM OF LOSS OR DAMAGE ON ACCOUNT OF ANY ALLEGED ERROR OR DEFECT IN ANY TESTING PROCEDURE OR RESULT.

IN NO EVENT SHALL PRINCIPLED TECHNOLOGIES, INC. BE LIABLE FOR INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH ITS TESTING, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL PRINCIPLED TECHNOLOGIES, INC.’S LIABILITY, INCLUDING FOR DIRECT DAMAGES, EXCEED THE AMOUNTS PAID IN CONNECTION WITH PRINCIPLED TECHNOLOGIES, INC.’S TESTING. CUSTOMER’S SOLE AND EXCLUSIVE REMEDIES ARE AS SET FORTH HEREIN.